Kurzweil 1000
Version 13
Quick Reference
Table of Contents

Shortcuts for Basic Kurzweil 1000 Functions. ...........................2
  Starting and Shutting Down Kurzweil 1000. ..........................2
  Turning Off the Computer. .................................................2
  System Messages and Help. ...............................................2
  What Time or Date is it? .....................................................2
  Basic Scanning. .................................................................3
  Basic Reading. .................................................................3
  Recognizing and Reading Currency. ....................................3
  Working with Forms. .......................................................4
  Playing Audio Files. ..........................................................4

Shortcuts for Dialog Boxes. ....................................................6
  General Dialog Box Navigation. ..........................................6
  Treeview Navigation. ..........................................................6

Shortcuts for Reading. ..........................................................7
  Reading Contextual Text. ....................................................7
  Reading Selected Text. ......................................................7
  Moving in and Reading Text. ..............................................8
  Reading by Alternate Unit. ................................................9
  Reading Tables. ...............................................................9
  Finding Tables. ...............................................................11

Document Overview Shortcuts. .............................................12

Shortcuts for Document Navigation. .....................................13
  Page Navigation. ............................................................13
  Cursor Navigation. .........................................................13
  Bookmark Navigation. .......................................................13
  Link Navigation. ............................................................14
  Creating Document Navigation. .........................................14
  Going from Open Document to Open Document. ..................14
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortcuts for Reference Tools and Online Searches.</td>
<td>15</td>
</tr>
<tr>
<td>Spelling</td>
<td>15</td>
</tr>
<tr>
<td>Definition and Synonym Lookup.</td>
<td>15</td>
</tr>
<tr>
<td>Online Searches.</td>
<td>16</td>
</tr>
<tr>
<td>Annotation Shortcuts.</td>
<td>17</td>
</tr>
<tr>
<td>Shortcuts for Editing.</td>
<td>18</td>
</tr>
<tr>
<td>Selecting Text.</td>
<td>18</td>
</tr>
<tr>
<td>Editing Text.</td>
<td>18</td>
</tr>
<tr>
<td>Finding and Replacing Text.</td>
<td>19</td>
</tr>
<tr>
<td>Proofreading.</td>
<td>20</td>
</tr>
<tr>
<td>Formatting Text.</td>
<td>21</td>
</tr>
<tr>
<td>File Management Shortcuts.</td>
<td>22</td>
</tr>
<tr>
<td>Opening and Closing Files.</td>
<td>22</td>
</tr>
<tr>
<td>Saving Files.</td>
<td>22</td>
</tr>
<tr>
<td>Printing Files.</td>
<td>23</td>
</tr>
<tr>
<td>Creating Files.</td>
<td>23</td>
</tr>
<tr>
<td>Deleting Files.</td>
<td>23</td>
</tr>
<tr>
<td>Converting Files.</td>
<td>24</td>
</tr>
<tr>
<td>Shortcuts for Miscellaneous Tools.</td>
<td>25</td>
</tr>
<tr>
<td>Function Keys.</td>
<td>25</td>
</tr>
<tr>
<td>Kurzweil 1000 Menus.</td>
<td>27</td>
</tr>
<tr>
<td>File Menu.</td>
<td>27</td>
</tr>
<tr>
<td>Finding and Opening a File.</td>
<td>28</td>
</tr>
<tr>
<td>Saving File to Another Folder or Changing File Name or Format.</td>
<td>29</td>
</tr>
<tr>
<td>Saving Partial Document or Range of Pages.</td>
<td>29</td>
</tr>
<tr>
<td>Launching Applications.</td>
<td>30</td>
</tr>
<tr>
<td>Working with File Utilities.</td>
<td>30</td>
</tr>
<tr>
<td>Creating a WAV, MP3 or DAISY File.</td>
<td>31</td>
</tr>
<tr>
<td>Monitoring the Audio File Creation Process.</td>
<td>31</td>
</tr>
<tr>
<td>Adding WAV or MP3 Files to iTunes or Windows Media Playlist.</td>
<td>32</td>
</tr>
<tr>
<td>Converting WAV or MP3 File to DAISY 2.0.</td>
<td>32</td>
</tr>
<tr>
<td>Sending Files.</td>
<td>32</td>
</tr>
<tr>
<td>Finding Recently Opened Files.</td>
<td>32</td>
</tr>
<tr>
<td>Edit menu.</td>
<td>32</td>
</tr>
<tr>
<td>Using Regular Expressions with Find and Replace.</td>
<td>33</td>
</tr>
<tr>
<td>Creating and Editing Tables.</td>
<td>34</td>
</tr>
<tr>
<td>Converting Text to a Table.</td>
<td>34</td>
</tr>
<tr>
<td>Converting a Table to Text.</td>
<td>34</td>
</tr>
</tbody>
</table>
Table of Contents

Filling in a Form. .................................................................35
Inserting a Signature File. ..................................................36
Folder menu. ........................................................................36
Scan menu. ..........................................................................37
  Flipping Sides for Double-Sided Pages. .........................37
  Optimizing Scanner Settings. ........................................38
  Interrupting and Saving Recognition. .............................38
  Optimizing Recognition Settings. .................................38
  Creating a Signature File. ..............................................38
Read menu. .........................................................................39
  Navigation menu. ............................................................40
  Settings menu. ...............................................................40
  Saving Partial Settings. ..................................................41
  Linking Documents and Settings. ......................................42
Tools menu. .........................................................................42
  Creating a New Corrections List. .....................................44
  Editing a Corrections List. ...............................................44
  Applying Corrections to a Document. ..............................45
  Obtaining Recognition Statistics. ..................................45
  Exploring Layout. ..........................................................45
  Using Ranked Spelling. ...................................................45
  Writing Files to a CD. ......................................................46
Online menu. ......................................................................47
Window menu. ...................................................................48
Help menu. .........................................................................48

Kurzweil 1000 Settings Tabs (From the Settings Menu) ..........50
  The Voices Settings Tab. ................................................50
  The Scanning Settings Tab. ............................................51
  The Recognition Settings Tab. .......................................52
  The Reading Settings Tab. ..............................................52
  The General Settings Tab. ..............................................53
  The Display Settings Tab. ..............................................54
  The Scanner Margins Settings Tab. .................................54
  The Configuration Settings Tab. ....................................55
  The Verbosity Settings Tab. ...........................................56
  The Conversion Settings. ..............................................56
The Kurzweil 1000 Keypad Layers. .........................................................57
  Reading (Kurzweil 1000) Keypad. ..................................................57
  Reading (Kurzweil 1000) Keypad Shifted. ..................................58
  Reading (Screen Reader) Keypad. ..................................................58
  Reading (Screen Reader) Keypad Shifted. .................................59
  File Management Keypad. ............................................................59
  File Management Keypad Shifted. ..............................................60
  Settings Keypad. .........................................................................60
  Settings Keypad Shifted. ..............................................................61
  Keypad Maps ...............................................................................62

Contacting Kurzweil 1000. .................................................................70
Kurzweil 1000 Quick Reference

All Kurzweil 1000 features and settings are accessible from the menu system. For most of the frequently used features, there are shortcut keys from the keyboard. In addition, many of the basic functions are accessible from keypad keys. This Quick Reference presents shortcut keys, menu mnemonics, and keyboard keys, as well as information about important features and settings.

For detailed information about any function or feature, press Alt+H, then O to Open the Manual from the Help menu. Note that this Quick Reference is also available from the Help menu by pressing Alt+H, then Q.
Section 1. Shortcuts for Basic Kurzweil 1000 Functions.

1.1. Starting and Shutting Down Kurzweil 1000.

Start Kurzweil 1000: Control+Alt+K. Note: For this shortcut to work, you must restart Windows after installing Kurzweil 1000.

Shut down Kurzweil 1000 using the keyboard: Alt+F+X.

Shut down Kurzweil 1000 using keypad keys: Cancel key twice, then the Accept key.

1.2. Turning Off the Computer.

Power off the computer using keypad keys: Cancel key three times, then the Accept key.

1.3. System Messages and Help.

Repeat the last system message: Shift+F2.

Help: F1.

Help for a dialog box: F2.

Open the Manual: Alt+H, then O.

Open the Quick Reference: Alt+H, then Q.

Version information for Kurzweil 1000: Alt+H, then A.

1.4. What Time or Date is it?

Control+T. Press once for time. Press again for date. To copy and paste time and/or date, use Control+C and Control+V.
1.5. **Basic Scanning.**

- Start and Stop Scanning: F9.
- Scan Repeatedly: Control+F9.
- For additional Scanning features, go to section 12.4 Scan Menu; for Scanning Settings, go to section 13.2 Scanning Settings.

1.6. **Basic Reading.**

- Start and stop reading: F5.
- Read slower: F11.
- Read faster: F12.
- Lower Volume: Shift+F11.
- Increase Volume: Shift+F12.
- For more Reading shortcuts, go to section 3 Shortcuts for Reading. For Reading features from the menu, go to section 12.5 Read Menu, and for Reading settings, go to 13.4 Reading Settings.

1.7. **Recognizing and Reading Currency.**

- Note: Recognizing currency requires a color scanner.
- Recognize and read currency: Shift+F9; opens a dialog. To select a country press Alt+R to go to the Currency list. To scan again, press Alt+S.
1.8. Working with Forms.

Scan a form, choose Scan as a Form from the Scan menu (Alt+S+M).

Note: scanning a page as a form affects one page at a time. This is true even when using a document feeder, in which case, only place one page at a time in the feeder when scanning forms.

Rerecognize a form, be sure you have the desired page open, then choose Rerecognize a Form from the Scan menu (Alt+S+E).

Note: this function will not work if the document you have open does not have an associated image.

If you plan on reusing the form, remember to save a copy.

Read a form: F5.

Move in text: use arrow keys and other navigation functions found in the section entitled, Moving in and Reading Text.

For details on filling out a form, go to section 12.2.4 Filling in a Form.

1.9. Playing Audio Files.

Open and play DAISY Audio 2.02 books, MP3 and Windows Media (WMA) files.

Stop and restart, press F5 or Right Control key.

Rewind, F6 or Left Arrow.

Repeat Current Unit, F7.

Fast Forward, F8 or Right Arrow.

Go to start of file, Control+Home. Go to end of file, Control+End.

Report current position in the file and time remaining, Shift+F1.
Change reading speed, F11 and F12. To save a desired speed, use Speech Speed in the Voice Settings tab.

If the DAISY audio book has page numbers, use Page keys to navigate.
Section 2. Shortcuts for Dialog Boxes.

2.1. General Dialog Box Navigation.

Help for any control: with the cursor in the control, press F1.

Go to the next control: Tab key.

Go to previous control: Shift+Tab key.

Go to a specific control: use the control's mnemonic keys, usually Alt+ a letter key.

Go through a list: Up and Down Arrow keys.

Apply changes without closing the dialog when there is an Apply button: Alt+Enter.

OK to apply changes and close the dialog: Enter key.

Cancel and close the dialog: Escape key.

2.2. Treeview Navigation.

Move among items at the same level or in the same directory: Up and Down Arrow keys.

Move to a sub-level of a directory: Right Arrow key.

Move to the level or directory above: Left Arrow key.

Read continuously through the list of items: F5.

Go to first item at same level: Home.

Go to last item at same level: End.

Go to first item in treeview: Control+Home.

Go to last item in treeview: Control+End.
Section 3. Shortcuts for Reading.

Read virtually any type of material in Kurzweil 1000, including, scanned documents, files imported or opened from other applications, downloaded electronic files from online sources, and documents created in Kurzweil 1000.

3.1. Reading Contextual Text.

Previous line: Control+Shift+U.
Current line: Control+Shift+I.
Next line: Control+Shift+P.
Previous word: Control+Shift+J.
Current word: Control+Shift+K.
Next word: Control+Shift+Semicolon.
Previous Reading Unit: F6.
Repeat Current Reading Unit: F7.
Next Reading Unit: F8.

3.2. Reading Selected Text.

First select text by placing the cursor at the starting point for the selection. Hold down the Shift key and use the Arrow keys to move over the text; stop where you want to end the selection. Then use the shortcut for any of the following options:

Say selected text: Control+Y.
Spell selected text: Control+Shift+Y.
3.3. Moving in and Reading Text.

Use any of the following shortcuts to move the cursor to a specific spot in the text and read from that position.

Word before the cursor: Control+Left Arrow.
Word after the cursor: Control+Right Arrow.
Line before the cursor: Up Arrow.
Line after the cursor: Down Arrow.
Start of current line: Home.
End of current line: End.
Start of current paragraph: Control+Up Arrow.
Start of next paragraph: Control+Down Arrow.
Move by screen forward: Control+Page Up.
Move by screen backward: Control+Page Down.
Previous page: Page Up.
Next page: Page Down.
Bottom of current page: Shift+Page Down.
Previous character: Control+Shift+M.
Current character: Control+Shift+Comma.
Next character: Control+Shift+Period.
Previous screen: Control+Page Up.
Next screen: Control+Page Down.
Beginning of document: Control+Home.
End of document: Control+End.
3.4. Reading by Alternate Unit.

Whatever your Reading Unit is set to, pressing the Reading by Alternate Unit shortcut keys reads text using the alternate unit. For example, if the Reading Unit is set to Paragraph, Alt+F8 forwards by and reads the next Sentence unit.

Move cursor forward to and read by Alternate Unit: Alt+F8 or Alt+Right Shift key.

Move cursor backward to and read by Alternate Unit: Alt+F6 or Alt+Left Shift key.

Reread the current Alternate Unit: Alt+F7.

Note: to select a Reading Unit, use the Reading Settings from the Settings menu. Go to section 13.4 Reading Settings for more information.

3.5. Reading Tables.

For best results, ensure that:

- The table has been recognized with the Table Recognition setting enabled in the Recognition Settings dialog.
- When you are ready to read the table, you enable the Table Reading setting in the Reading Settings dialog.
- The cursor is positioned in the table when using any of the following table reading shortcuts.

Help while in a table: F1.

Skip past a table: Control+Shift+Right Square Bracket.

Move cursor to just above the current table: Control+Shift+Left Square Bracket.

Report the size of the table: Shift+F1 twice.
Read row by row: F5.
Read column by column: Shift+F5.
Read first row without moving the cursor: Alt+ the Grave Accent key.
Read current row without moving the cursor: Control+Shift+W.
Read current column without moving the cursor: Control+Shift+C.
Move cursor to next row and read the contents: Control+Alt+Down Arrow.
Move cursor to previous row and read the contents: Control+Alt+Up Arrow.
Move to and read next cell in the current row: Tab key.
Move to and read previous cell in the current row: Shift+Tab key.
Read the contents of the current cell: F7.
Report the position of the current cell: Shift+F1.
Read the contents of the first cell in the current row: Alt+Left Arrow key.
Read the contents of the last cell in the current row: Alt+Right Arrow key.
Read the contents of the first cell in the current column: Alt+Up Arrow key.
Read the contents of the last cell in the current column: Alt+Down Arrow key.
Read the current cell preceded by its row and column headings: Shift+F1.
3.6. Finding Tables.

Open the Find dialog, Control+F. In the Find box, type backslash plus the letter L, or press the Up/Down Arrow key until Kurzweil 1000 announces "Tables."
Section 4. Document Overview Shortcuts.

There are three document overview methods: Browsing, Summarization, and Layout Exploration. There are no shortcuts for Summarization and there are Layout Exploration shortcuts once you choose the Explore Layout command from the Tools menu. Go to Section 12.8.5, Exploring Layout, for menu access information; and to the Online Help Manual for details.

Start browsing: Shift+F5. By default, Kurzweil 1000 browses the first sentence in each paragraph. To change browse method, use the Browse Method list in Reading Settings. For more on Reading settings, go to section 13.4.

Skim forward: Right Shift key while reading continuously.

Skim backward: Left Shift key while reading continuously.


Go to a specific page: Control+G, then enter the page number. If there are user-defined Preliminary pages, type letter "P" before the page number. For more on setting User Page Number, go to section 12.6 Navigation Menu.

5.2. Cursor Navigation.

Return to and report last cursor position: Control+F5.

For additional cursor navigation while reading in text, go to section 3.3. Moving in and Reading Text.

5.3. Bookmark Navigation.

Go to a bookmark: Control+R; opens the Bookmark dialog. (If shortcuts emphasize Format Editing, use Control+Shift+R.)

The following are shortcuts you can use while in the Bookmark dialog:

Search for a specific bookmark description: Control+F, then enter a word or phrase from the description you would like to find.

Search forward for the next bookmark description that matches your search: F3.

Search backwards for the bookmark description that matches your search: Shift+F3.

Sort bookmarks list: Control+S; sort by Page Number, Subject, Page Number and Level.
5.4. **Link Navigation.**

Select a link to go to: Control+F7; opens the Link dialog. Choose a link from the Select a link list. Press the Enter key to go to the link. Activate a nearby link and go to the destination text: Shift+Enter.

5.5. **Creating Document Navigation.**

Create a single bookmark: Control+B. (If shortcuts emphasize Format Editing, use Control+Shift+B.)

Create multi-level bookmark: Control+B+B; opens a dialog. (If shortcuts emphasize Format Editing, use Control+Shift+B+B. If shortcuts emphasize Format Editing, use Control+Shift+R+R.) In the dialog, enter the description. To select a Chime for the bookmark: Alt+C. To select a Level: Alt+L.

Edit or delete bookmark: Control+R; opens the Bookmark dialog. In the Bookmark dialog, select the bookmark by using list or treeview navigation to find it (Control+F also works). To delete the bookmark: Press letter D key. To edit the description: Alt+P. To change the Chime: Alt+C. To change the Level: Alt+L.

Create an internal link: Control+Shift+F7, then follow the voiced instruction.

Edit a link: Control+F7; opens the Link dialog. In the dialog, select the link. To edit the description: Alt+P. To delete a link: Alt+D.

5.6. **Going from Open Document to Open Document.**

Previous document: Control+Shift+Tab.

Next document: Control+Tab.

6.1. Spelling.

Spell the word: Control+L. (If shortcuts emphasize Format Editing, use Control+F12.)

Spell using word alphabet: Control+Shift+L. (If shortcuts emphasize Format Editing, use Control+Shift+F12.)

6.2. Definition and Synonym Lookup.

To define a Word: Control+D; opens the Lookup dialog. Enter a word or phrase (Alt+W) or use the Up/Down Arrow keys to select from your previously searched words. To select from the Part of Speech list, press Alt+S. To select another Dictionary, including bilingual dictionaries: Alt+I. To hear the Next definition: Alt+N. To hear the previous definition: Alt+P.

To hear human pronunciation of the word: In the Lookup dialog, press ALT+O for Pronounce. To find and hear anagrams for a word: In the Lookup dialog, press ALT+A for Anagrams. If anagrams exist for the word, Kurzweil 1000 tells you how many matches were found. Press TAB to go to the Anagrams list. If you select an anagram, Kurzweil 1000 presents its definition. Note: Pronounce and Anagrams require the installation of the American Heritage Dictionary Pronunciation WAV files included in the Kurzweil 1000 product CD.

To copy the entire definition to the clipboard for pasting into another document, even in one that is in another application, Control+W.

Use the Thesaurus: Shift+F7; opens the Lookup dialog. Enter a word (Alt+W) or use the Up/Down Arrow keys to select from your
previously searched words. To select from the Part of Speech list, press Alt+S. To hear the Thesaurus source: Alt+T. To hear the Next synonym: Alt+N. To hear the previous synonym: Alt+P.

Switch between Definitions and Synonyms. To find the word's synonym while in the definition lookup: Shift+F7. To find the word's definition while in the synonym lookup: Control+D.

6.3. **Online Searches.**

Open the Online menu: Alt+N.

Search for Books: S.

Search for Magazines: M.

Use an Encyclopedia: E.
Section 7. Annotation Shortcuts.

There are two features you can use for annotations: Notes and Bookmarks. For more on Bookmarks, go to sections 5.3 Bookmark Navigation and 5.5 Creating Document Navigation. It is also possible to convert Bookmarks to Notes, accessible from the File Utilities submenu.

Create a Note: Control+Shift+Q. Opens a dialog; type your note.

Read a Note: Control+Q; opens the Note dialog. In the dialog, select and hear notes in the list by using the Up/Down Arrow keys. To change the sort order: Control+S. To search Note descriptions: Control+F.

Edit a note: in the Note dialog, select a note, press Alt+P to go to the Description text box, then edit.

Delete the selected note: in the Note dialog, select a note, then press Alt+D.

You can also use bookmarks and Notes in conjunction with the Summarize feature from the File menu to extract annotations into a study guide, outline or table of contents.
Section 8. Shortcuts for Editing.

When editing, text navigation can be handy; go to 3.3 Moving and Reading Text for text navigation shortcuts.

8.1. Selecting Text.

Select a character to the left or the right: Shift+Left or Right Arrow.
Select a word to the left or the right: Control+Shift+Left or Right Arrow.
Select a line above or below: Shift+Up or Down Arrow.
Select to beginning of current line: Shift+Home.
Select to end of current line: Shift+End.
Select paragraph from cursor position up or down: Control+Shift+Up or Down Arrow.
Expand amount of selected text: Control+F8.
Contract amount of selected text: Control+Shift+F8.
Select all text in a document: Control+A.
Select text for copying/cutting/pasting: place cursor at the beginning of the selection. Press Control+M to mark the position, move cursor to the end of the selection.
Say selected text: Control+Y.
Spell selected text: Control+Shift+Y.

8.2. Editing Text.

Erase character to left of cursor: Backspace key.
Erase character to right of cursor or selected text: Delete key.
Quick Reference

Erase word to left of cursor: Control+Backspace key.
Erase word to the right of cursor: Control+Delete.
Undo: Control+Z.
Cut: Control+X.
Copy: Control+C.
Paste: Control+V.
Delete next word: Control+Delete.
Delete last word: Control+Backspace.
Change pronunciation for a word: Control+Shift+N; opens the Pronunciation dialog. Enter the word, then TAB to enter the pronunciation.

8.3. Finding and Replacing Text.

Control+F opens the Find dialog. In the dialog, type the text you want to find, then specify any of the following options:
To find text by its Format: press Alt+O, then select the desired format from the list.
To find text by its exact match: press Alt+W, then select Enabled from the list.
To find text by the exact case, press Alt+S and select Enabled from the list.
You can also find text by using Regular Expressions. In the Find dialog, Tab until you hear Use Regular Expression or press Alt+U; enter the desired regular expression.
Additional features and options in the Find dialog are:
Read context: press Alt+X.
8.4. Proofreading.

Check Spelling from cursor position or for selected text: Control+K; opens the Spell Checker dialog. In the dialog, to replace a word, press Alt+R. To replace the word throughout the entire document, press Alt+A. To hear the context of the word: Alt+X. To hear the word spelled out: Alt+S. To ignore the word: Alt+I. To ignore all instances of the word: Alt+L. To add the word to the Spell Checker Word list: Alt+D.

Change Spell Check properties: Control+K to open the Spell Checker dialog, then press Alt+P to open the Properties dialog. To ignore Capitalization: Alt+Z, then select Ignore from the list. To ignore All Caps: Alt+P. To ignore Partial Numbers: Alt+N. To ignore user-specified prefixes and suffixes: Alt+Shift+P for Prefixes and Alt+S for Suffixes.
Move forward word by word and hear full punctuation and capitalization: Control+Alt+Right Arrow.

Move backward word by word and hear full punctuation and capitalization: Control+Alt+Left Arrow.

8.5. Formatting Text.

Report format: Control+Shift+F.

Center paragraph: Control+E.

Justify paragraph: Control+J.

Right align: Control+Shift+R. (If shortcuts emphasize Format Editing, use Control+R.)

Left align: Control+F12. (If shortcuts emphasize Format Editing, use Control+L.)

Bold: Control+Shift+B. (If shortcuts emphasize Format Editing, use Control+B.)

Italicize: Control+I.

Underline: Control+U.

Decrease font size by one point: Control+Left Bracket.

Increase font size by one point: Control+Right Bracket.

Insert page break: Control+Enter.

There are additional Font and Paragraph changes available from the Edit menu.

This section lists general File Management functions accessible by shortcut keys. For additional file functions such as changing File Properties, Copying, Moving, Merging, Creating Audio File, and Sending files To, use the File menu; go to section 12.1 File Menu for details.

For Folder functions, such as changing folders, use the Folder menu; go to section 12.3 Folder Menu for details.

9.1. Opening and Closing Files.

Kurzweil 1000 opens virtually any file, including PDF, Microsoft Word, Grade 2 Braille and image files.

Open file: Control+O; opens the File dialog; the cursor is in the File list. Select the file to open, then press Enter. If the file has bookmarks, use the arrow keys to navigate the bookmarks. Stop when you hear the bookmark you want, then press Enter.

Open text file from floppy disk: Control+Shift+O.

Open KES file from current folder: Control+Shift+A.


Notes: When opening a non-encrypted PDF file, Kurzweil 1000 collects the file’s bookmarks, allowing you to go to the bookmarked page. When opening a multipage image file, Kurzweil 1000 allows you to recognize a subset of the file.

9.2. Saving Files.

Save file: Control+S. If it’s a new document, the File dialog opens.

Save as text file to floppy disk: Control+Shift+S.
Save as KES file to current folder: Control+Shift+H.
Save file to another folder or change file name or format: use the Save As feature from the File menu; go to section 12.1.2 for details.
Save partial document or range of pages: use Save Partially from the File menu; go to 12.1.3 for details.

9.3. Printing Files.

Print: Control+P; opens the Print dialog; the cursor is in the Printer list.

Print range of pages: in the Print dialog, press Alt+G, then select the Pages option, TAB to the From box to specify first page, TAB to the To box and specify the last page.

Print selected pages: select text, then in the Print dialog, press Alt+G, select the Selection option.

Print multiple copies: in the Print dialog, press Alt+C to go to the Number of Copies text box, then type a number from 1-99.

Change Print properties: in the Print dialog, press Alt+B. Set font, magnification, orientation Paper Source and Size, and/or line spacing.

9.4. Creating Files.

Create new file: Control+N.

9.5. Deleting Files.

Delete selected file(s) or folder(s) in File dialog: Shift+Delete.
Delete text file from floppy disk: Control+Shift+D.
Delete KES file from current folder: Control+Shift+E.
9.6. Converting Files.

Braille conversion: Control+P to open the Print dialog; Alt+B to go to the Braille Conversion list, select Enabled.
Section 10. Shortcuts for Miscellaneous Tools.

What Time is it? Control+T. What’s the Date? Control+T twice.
Show Image: Control+W.

Section 11. Function Keys.

F1. Help for control.
Shift+F1. Report line and page number.
Control+F1. Report Position of word on scanner.
F2. Help for dialog box.
F3. Find next.
Shift+F3. Find Previous.
F5. Start reading.
Shift+F5. Start browsing.
Control+F5. Go to last position.
F6. Rewind.
Shift+F6. Previous region.
Control+Shift+F6. Previous document.
F7. Read current unit.
Shift+F7. Use Thesaurus.
F8. Forward to next unit.
Shift+F8. Next region.
Control+F8. Expand selection.
Control+Shift+F8. Shrink selection.
Shift+F9. Recognize currency.
Control+F9. Scan repeatedly.
F10. Access menus.
Shift+F10. Access context menu.
F11. Read slower.
F12. Read faster.
Section 12. Kurzweil 1000 Menus.

This section presents menus and their content. Additional information is included for certain advanced functions and features.

To access the Kurzweil 1000 menus, press Alt, then the mnemonic for the menu name and item. For example, Alt+F for the File menu. Some items have keyboard shortcuts and a number of items open dialog boxes.

Note: To hear a menu item spelled aloud, press Control+L or Control+Shift+L.

12.1. File Menu.

Press Alt+F to go to the File menu, then use the mnemonic for the operation you want to perform:

N. for New. The keyboard shortcut is Control+N.

O. for Open. The keyboard shortcut is Control+O. Opens the File dialog.

C. for Close. (Visible only if file is open.) The keyboard shortcut is F4.

S. for Save. (Visible only if file is open.) The keyboard shortcut is Control+S.

A. for Save As. (Visible only if file is open.) Opens the File dialog. Go to subsection 12.1.2 for additional details.

T. for Save Partially (Visible only if file is open.) Opens a dialog. Go to subsection 12.1.3 for additional details.

D. for Delete. Opens the File dialog.

F. for Favorites. Opens the Favorites dialog.

V. for Add to Favorites. (Visible only if file is open.)
P. for Print. (Visible only if file is open.) The keyboard shortcut is Control+P.

I. for Find and Open. Go to subsection 12.1.1 for additional details.

M. for Summarize. (Visible only if file is open.) Opens a dialog; type the subject or subjects.

L. for Launch. Has a submenu. Go to subsection 12.1.4 for additional details.

U. for Utilities. Has a submenu. Go to subsection 12.1.5 for additional details.

E. for Send To. Has a submenu. Go to subsection 12.1.7 for additional details.

R. for Properties. (Visible only if file is open.) Opens the File Properties dialog.

Y. Recently Opened. Has a submenu. Go to subsection 12.1.8 for additional details.

X. for Exit.

12.1.1. Finding and Opening a File.

Alt+F, then letter I opens the Find and Open dialog. In the dialog, type the word or words to search for. To change the directory, go to the Look under list, Alt+L.

To use bookmarks to open a file, select the file and press Right arrow. In the Bookmark window that opens, use bookmark navigation to go to the desired one, then press Enter.

Other options in the File Open dialog include: Look at List, Alt+K, to search for File Name or Contents of a file. The Case Sensitivity list, Alt+S and the Match Requirements list, Alt+M. To go to the results list, press Alt+R.
12.1.2. Saving File to Another Folder or Changing File Name or Format.

Alt+F, then A opens the file dialog. To save the file to another folder, type the entire path name in the File Name text box. To change the file name, type the new name in the File Name text box. To save the file in another format: press the Tab key to go to the Format list and select the desired format.

Kurzweil 1000 supports the following file formats: text, WordPerfect for Windows, Braille Grade 2, Daisy, HTML, HTML 3, KES, MS Excel, Microsoft Word for Windows, and RTF. Select the Other option for other file formats.

12.1.3. Saving Partial Document or Range of Pages.

Alt+F, then T opens the Save Partially dialog. There are two ways to save partial documents: by selected text or by a range of pages.

To save selected text as a new document, select the text, then in the Save Partially dialog, press Enter to open the File dialog. Type a new name.

To save a range of pages to a new document, in the Save Partially dialog, type the first page to print. Press Tab, then type the last page to print. Press Enter to open the File dialog. Type a new name.
12.1.4. Launching Applications.

Alt+F, then L displays the Launch submenu, which contains the following items:
Add, mnemonic A.
Change, C.
Delete, D.
Appointment Calendar, M.
Calculator, L.
Photocopier, P.
FAX, X.

Applications that you add also appear in this menu. Alt+H in any Kurzweil 1000 application provides online Help.

12.1.5. Working with File Utilities.

Alt+F, then U displays the Utilities submenu which has three items when no file is open: Copy, mnemonic C. Move, M. Merge and Open, G. If a file is open, it contains the following additions:
Extract Image, E.
Extract All Images, X.
Remove Image from Page, R.
Remove All Images from File, I.
Remove Layout Information from File, L.
Remove Page Headers and Footers, H.
Create Audio Files, T.
Audio Spooler Monitor, O.
Convert Bookmarks to Notes, mnemonic V.

12.1.6. Creating a WAV, MP3 or DAISY File.

Have the file you want converted open. Next, open the Audio File Creation dialog by pressing Alt+F, then U, then T.

If Kurzweil 1000 tells you that your system does not have an MP3 Encoder, Tab until you hear "Get MP3 Encoder," then press Enter to activate an MP3 Encoder via the Internet.

All the following options are in the Audio File Creation dialog.

By default Kurzweil 1000 creates an audio file from the entire document. To specify a range of pages to process, in the Range list (Alt+G), use the Up/Down Arrow to select the Pages option, then use Tab to go to the From and To fields and enter the desired From and To pages.

To choose the Audio Format, press Alt+R and use the Up/Down Arrow key. To specify the Destination Folder: Alt+D. To Browse for the Destination Folder: press Alt+B, which opens the File dialog.

To specify Bookmarks as Separators, press Alt+B. To specify the Bookmark Level to use: Alt+V. To specify Pages per Audio File: Alt+P. For Audio Quality: Alt+A. For Bit Rate: Alt+I and for Sample Rate, press Alt+S.

12.1.7. Monitoring the Audio File Creation Process.

12.1.8. Adding WAV or MP3 Files to iTunes or Windows Media Playlist.

You must have the player on your system to use this feature.

Open the Audio File dialog. To add a WAV or MP3 file to iTunes Playlist, press Alt+T. To add to the Windows Media Player Playlist, press Alt+W.

12.1.9. Converting WAV or MP3 File to DAISY 2.02.

Open the file. Press Alt+F+A to open the File Save As dialog. Tab to the File Format List and type or arrow down to DAISY 2.02.

12.1.10. Sending Files.

Alt+F, then E displays the Send To submenu. When a file is open, the submenu contains: Send Current Document, mnemonic C and Send Other Document, O. When no file is open, the File dialog appears. Select a file, then in the Devices list, select Send To.

Note: You can set up any device that emulates a PC disk drive. For details, go to the online Help Manual, and search for User Device.

12.1.11. Finding Recently Opened Files.

Alt+F, then Y displays the Recently Opened submenu, which may contain names of up to 10 files you recently opened. Use mnemonics 1 through 9 to select which you want to open, 1 being the most recent.

12.2. Edit menu.

The Edit menu is visible only if a file is open.
Quick Reference

Press Alt+E, then one of the following mnemonics:

U. for Undo. The keyboard shortcut is Control+Z.
T. for Cut. The keyboard shortcut is Control+X.
C. for Copy. The keyboard shortcut is Control+C.
P. for Paste. The keyboard shortcut is Control+V.
G. for Cut Page.
S. for Paste Page.
A. for Select All. The keyboard shortcut is Control+A.
F. for Find. The keyboard shortcut is Control+F.
N. for Find Next. The keyboard shortcut is F3.
V. for Find Previous. The keyboard shortcut is Shift+F3.
R. for Replace. The keyboard shortcut is Control+H.
M. for Mark a Position. The keyboard shortcut is Control+M.
O. for Format. Has a submenu that contains Font, mnemonic F, and Paragraph, P.
E. for Create a Note. Keyboard shortcut, Control+Shift+Q.
B. for Table. Has a submenu.
L. for Fill a Field. Keyboard shortcut, Control+F3. Opens one or more in a series of forms fill-out dialogs.
I. for Insert a Signature.

12.2.1. Using Regular Expressions with Find and Replace.

In either the Find or Replace dialog, you can use regular expressions. Press Tab to go to "Use Regular Expressions," press
the Down Arrow key to Enable the feature. In the Find and/or Replace With text box, enter your regular expression.

12.2.2. Creating and Editing Tables.

Alt+E, then B displays the Table submenu. To create a table, press mnemonic I for Insert a Table. Type the number of columns, press Tab and type the number of rows.

Table editing functions on the Table submenu are: Insert a Row Above, mnemonic A. Insert a row Below, B. Insert a Column to the Left, L. Insert a Column to the Right, R. Delete Entire Row, O. Delete Entire Column, C. Delete Entire Table, D. Select Entire Table, S.

12.2.3. Converting Text to a Table.

Each row that you want for the resulting table must be a separate paragraph with a hard return. Indicate columns by inserting tabs. Select the text to be included in the table by using the Shift+Right and Down arrow key method. Then press Alt+E, then B, then T to Convert to Table.

12.2.4. Converting a Table to Text.

With the cursor in the table, press Alt+E, then B, then V.
12.2.5. Filling in a Form.

There are two ways to fill out a form after you have scanned as a form, by choosing Fill a Field from the Edit menu, Alt+E, then L, or Control+F3, or, if you have some vision, by choosing Show Image from the Tools Image Display submenu; the shortcut is Control+W.

When using Show Image, you can magnify the image, invert it, read the recognized text, move among the form fields and select or type in responses as you would in when using Fill a Field.

When using Fill a Field, and there are more than five fields, Kurzweil 1000 presents multiple dialogs. To go to the Next dialog: Alt+N. To go Back to the previous dialog: Alt+B. Note: both these actions save any changes you have made in the current dialog.

To move among the fields in the dialogs: Tab and Shift+Tab.

To hear the state of a field: F7. For additional information: press Shift+F7.

To hear the recognized text found near the field: Control+F7.

In a checkbox field, use the Up or Down arrow to select the desired choice.

To find out if a text field contains multiple lines: Shift+F7. To end a line and begin another: Control+Enter.

To save edits in the Form Fill dialog and close the dialog, press Enter. Your cursor returns to the open document.

To close the dialog without saving edits, press the Escape.

To add a signature file, ensure that your cursor is in the desired field and that the field is a text box, then press Control+Up or Down arrow until you reach the desired signature file. Go to the section entitled, Creating a Signature File for additional details.
When you have completed filling in a form, use the Save function to save the document.

To print the image file containing the contents of the fields you have filled out, select Yes for the Use Images option in the Print dialog.

12.2.6. Inserting a Signature File.

You can insert a signature in any document or in any form field. For details on adding a signature to a form field, go to the section entitled, Filling in a Form.

To insert a signature file into a document, place the cursor where you want to insert the signature, then choose Insert Signature from the Edit menu (Alt+E, then I).

12.3. Folder menu.

Press Alt+L, then one of the following mnemonics:

N. for New. Opens a dialog.
C. for Change. Opens a dialog. The cursor is in the Folder tree.
D. for Delete. Opens a dialog. The cursor is in the Folder tree.
F. for Favorites. Opens a dialog.
A. for Add current folder to Favorites List.
H. for Document Home. (Available only if no file is open.)
12.4. **Scan menu.**

Press Alt+S, then one of the following mnemonics:

- **S.** for Start New Scan. The keyboard shortcut is F9.
- **P.** for Scan Repeatedly. The keyboard shortcut is Control+F9.
- **M.** for Scan as a Form.
- **R.** for Rescan Page. (Available only if file is open.)
- **I.** for Insert Scan. (Available only if file is open.)
- **C.** for Rerecognize Page. (Available only if file is open.)
- **U.** for Rerecognize Multiple Pages. (Available only if file is open.)
- **E.** for Rerecognize as a Form. (Available only if file is open.)
- **F.** for Flip Sides. Opens a dialog.
- **O.** for Optimize Scanning. Opens a dialog.
- **G.** for Optimize Recognition. Opens a dialog.
- **C.** for Create a Signature File.

12.4.1. **Flipping Sides for Double-Sided Pages.**

This is necessary when using the automatic document feeder but can also be an option when not using one. Scan odd numbered pages first in ascending order. Then flip sides and scan the matching even numbered pages in descending order. Note: the Scanning Mode on the Scanning Settings must be set to Scan and Recognize or Image Scanning Only.
12.4.2. Optimizing Scanner Settings.

Alt+S, then O opens the Optimize Scanner Settings dialog. Settings include the following which are all lists with the options Optimize and Do Not Optimize: Thresholding: Alt+T; Brightness: Alt+B; Resolution: Alt+R; Speckle Removal: Alt+K; Text Quality: Alt+Q; Engine: Alt+N.

12.4.3. Interrupting and Saving Recognition of a Multi-Page Image or PDF File.

To interrupt recognition, press Escape. At this point, you can Save and Close the file if you want to later resume the recognition process. Note: if you want to later resume recognition, do not remove the original image file.

To later resume recognition, open the file if it isn’t already, then press F9 or Start New Scan key.

12.4.4. Optimizing Recognition Settings.

Alt+S, then O opens the Optimize Recognition Settings dialog. By default, Kurzweil 1000 finds the best Text Quality and Engine settings. When optimization is complete, press Enter to keep the newly recognized page or Escape to discard it.

Note: Keep Images setting in General Settings must be enabled.

12.4.5. Creating a Signature File.

First, write your signature in the upper left portion of a blank piece of paper, making sure it is not too close to the edges.

Choose Create a Signature File from the Scan menu (Alt+S, then C).
Place the paper on the scanner following directions from Kurzweil 1000, and press Enter to start the scan.

A dialog appears displaying the signature. Increase or decrease magnification in this dialog by using Control+Up or Down arrow. To accept a signature, press Enter. To discard the current signature, press Escape.

Next, name the signature file. If you would rather overwrite an existing signature file, use the Up/Down arrows to select the desired one.

For information on inserting a signature file into a document, go to section 12.2.5 Inserting a Signature File. For details on adding a signature to a form field, go to the section entitled, Filling in a Form.

12.5. Read menu.

The Read menu is visible only if a file is open.

Press Alt R, then one of the following mnemonics:

S. for Start Reading. The keyboard shortcut is F5.

W. for Start Browsing. The keyboard shortcut is Shift+F5.

R. for Rewind by Unit. The keyboard shortcut is F6.

C. for Read Current Unit. The keyboard shortcut is F7.

F. for Forward by Unit. The keyboard shortcut is F8.

L. for Spell. The keyboard shortcut is Control+L.

I. for Increase Reading Speed. The keyboard shortcut is F12.

E. for Decrease Reading Speed. The keyboard shortcut is F11.

Y. Say Selection. The keyboard shortcut is Control+Y.

N. Read a Note. The keyboard shortcut is Control+Q.

Press ALT+T, then one of the following mnemonics:

G. for Go to Page. The keyboard shortcut is Control+G.
B. for Go to Bookmark. The keyboard shortcut is Control+R. Opens the Bookmark dialog. Additional details are in section 5.3.
L. for Select a Link. The keyboard shortcut is Control+F7. Opens the Link dialog. Additional details are in section 5.4.
A. for Activate a Link. The keyboard shortcut is Shift+Enter.
P. for Go to Last Position. The keyboard shortcut is Control+F5.
E. for Set User Page Number. Opens the Set Page Number dialog. Type the new page number for the current page.
U. for Unset User Page Number.
K. for Create a Bookmark. The keyboard shortcut is Control+B. Additional details are in section 5.5.
L. Create a Link. The keyboard shortcut is Control+Shift+F7. Additional details are in section 5.5.

12.7. Settings menu.

Press ALT+T, then one of the following mnemonics. Additional details are available in Section 13, Kurzweil 1000 Settings.

E. for Voices Settings dialog.
S. for Scanning Settings dialog.
C. for Recognition Settings dialog.
R. for Reading Settings dialog.
G. for General Settings dialog.
D. for Display Settings dialog.
M. for Scanner Margins Settings dialog.
F. for Configuration Settings dialog.
Y. for Verbosity Settings dialog.
N. for Conversion Settings dialog.
V. for Save Settings. Opens the Settings File Name dialog. Type the name of the file to which you want to save the settings. You can also select the name from the File Name list.
L. for Load Settings. Opens the Settings Files dialog, Use the list to select the file to load.
T. for Delete Settings. Opens the Settings Files dialog, Use the list to select the file to delete.
B. for Backup Settings. Opens the File dialog. Select the desired folder and file or type a new file name.
O. for Restore Settings. Opens the File dialog. Select the desired folder and file.

12.7.1. Saving Partial Settings.

The Save Partial Settings feature makes certain settings available throughout Kurzweil 1000.

After making changes to settings, press Alt+T, then P to open the Save Partial Settings dialog. From the Category to Save list, select one of the settings categories: Miscellaneous, Conversion, Voices, Scanning, Recognition, Reading, General, Display, Scanner Margins, Configuration, Verbosity, and Launch Items. Press the Tab
key to go to the Settings Files list and select one or more files to which you want to save the settings.

12.7.2. Linking Documents and Settings.

Link Documents and Settings is in the Configuration Settings dialog (Alt+T, then F). You can reach its list by pressing Alt+I in the dialog. The options are as follows:

Disabled, which is the default.

Scanning Settings Only, which links scanning, recognition and scanner margin settings to documents.

Most Settings, which links the settings associated with the Scanning Settings Only option, in addition to Voice, Reading, General and Verbosity settings.

12.8. Tools menu.

Press ALT+O, then one of the following mnemonics:

A. for Apply Corrections. (Available only if file is open.) More details are in section 12.8.3 below.

K. for Check Spelling. (Available only if file is open.) The keyboard shortcut is Control+K. Go to section 8.4 Proofreading.

E. for Edit Corrections. Opens the Edit Corrections dialog. More details are in section 12.8.2 below.

S. for Edit Spell Checker Word List. Opens a dialog. The cursor is in the word list. To add a new word: Alt+A. To delete a word, select it from the list, then Alt+D.

P. for Edit Pronunciations. Opens a dialog. The cursor is in the word list. To add a new word: Alt+A. To test the pronunciation: Alt+T. To delete a word, select it from the list, then Alt+D.
N. for New Pronunciation. The keyboard shortcut is Control+Shift+N. Opens a dialog. The cursor is in the Word to be spoken box; type the word or phrase. Press Tab to go to the Pronunciation box and type the new pronunciation. To test the pronunciation: Alt+T.

R. for Recognize Currency. The keyboard shortcut is Shift+F9. Opens a dialog. Alt+R to go to select from the Country list. To scan again, Alt+S.

G. for Generate Bookmarks. (Available only if file is open.) Opens a dialog. Type the subject, press Enter.

T. for What Time is it. The keyboard shortcut is Control+T.

F. for Select Corrections File. Opens the Select Corrections List dialog. More details are in section 12.8.1 below.

D. for Define a Word. The keyboard shortcut is Control+D. To hear the word pronounced using a human voice, press Alt+O (this requires installed Pronunciation WAV files; for more information, go to the online Help manual.) To find anagrams, press Alt+A.

U. for Use the Thesaurus. The keyboard shortcut is Shift+F7.

O. for Recognition Statistics. (Has a submenu when a file is open.) More details are in section 12.8.4 below.

L. for Explore Layout. (Available only if file is open.) Opens a dialog. More details are in section 12.8.5.

Y. for Image Display. (Available only if file is open.) Has a submenu with three items: Show Image to display maximized image, Show Both Image and Text to display split screen of the image and the text, and Hide Image to show only the text. Press the keyboard shortcut Control+W to access the Image Display submenu and to cycle through the three options. To use this feature, the Keep Images option must be enabled in the General Settings. Press F1.
for Help. Use F5 to start and stop reading. Use Page Up, Page Down, continuous reading and Go to Page in the image view. When showing both image and text, use Control+Tab to move between the two views.

I. for Ranked Spelling. (Available only if file is open.) Opens the Ranked Spelling dialog. More details are in section 12.8.6.

C. CD Writing Tasks. (Available only if your system has a CD burner and is running Windows 2003, Windows XP or more recent operating system.)


Corrections lists let you apply pre-defined corrections throughout a document.

Alt+O, then F opens the Select a Corrections File dialog. Type the name of the new file you want. Press Enter. Next, press Alt+O, then E to open the Edit Corrections dialog. Press Alt+A to Add a new word or phrase to be corrected. Press Enter. Type the replacement.

12.8.2. Editing a Corrections List.

Alt+O, then E opens the Edit Corrections dialog. Select a word or phrase from the Find list (Alt+F) then type its replacement in the Replace With box (Alt+H). You can also enable Case Sensitivity (Alt+S). Alt+A lets you add a new word and replacement. To delete a word and its replacement, select it from the Find list then press Alt+D.
12.8.3. Applying Corrections to a Document.

To apply a corrections list to a document, open the document, Select a Corrections File (Alt+O, then F), then choose Apply Corrections (Alt+O, then A).

12.8.4. Obtaining Recognition Statistics.

Recognition Statistics provide reports on the performance of the character recognition process. The statistics can help inform scanning settings and optimization decisions.

When a file is open, the Recognition Statistics submenu contains the following items, each of which opens a dialog:

Last Page, mnemonic L, for statistics on the last page.

Cumulative, C, for statistics about all the pages.

Poorly Recognized Pages, P, for a list of those pages in the document that were poorly recognized.

Use the Tab and Shift+Tab keys to navigate the statistics.

12.8.5. Exploring Layout.

Be sure Keep Layout Information setting in the General Settings dialog is enabled. In the Explore Layout dialog, a text box contains a brief summary of the page's regions. Press Tab to go to the data table that describes the regions in detail. Use Table reading commands.


Ranked spelling provides statistics that help you assess how much of a file, particularly a large one, is correctly spelled. Alt+O, then I opens the Ranked Spelling dialog. After the message indicating the
percentage of the words spelled correctly, use the Tab key to go to the list of misspelled words.

To correct a word, select it from the list. Press Tab then type your correction.

It's also possible to: hear the word's spelling: Control+L; Ignore the word Alt+I; Add it as is to the Word list: Alt+D; Replace All, Alt+A; Search for a word in the list: Control+F; set Properties such as capitalization, partial numbers, and prefixes and suffixes by pressing Alt+P.

To copy the list of misspelled words for pasting into another document, even in another application: press Control+C while in the Ranked Spelling list.

Press F1 for Help.

12.8.7. Writing Files to a CD.

If your system has a CD burner and is running Windows 2003, Windows XP or a more recent operating system, you can find the CD Writing Tasks submenu from the Tools menu by pressing Alt+O, then C. The general procedure follows:

Be sure you have a writable CD in the CD burner.

If you have multiple CD drives that can write CDs, press L from the CD Writing Tasks submenu to Select a Drive, otherwise go to the next step.

Add Files to the queue by pressing A from the CD Writing Tasks submenu. In the File dialog, select the desired folder, file or files.

Lastly, Start Writing the files to the CD by pressing W from the CD Writing Tasks submenu.
To directly write the contents of a folder onto a CD without first adding those contents to a queue, press D.

To obtain status before you begin writing to CD, press S from the CD Writing Tasks submenu. You may hear some or all of the following information: total size of the files, whether or not a CD is in the drive, and how much free space is available on the CD.

To remove files from the queue, press R from the CD Writing Tasks submenu. To erase all the files from a CD, press E.

Note: the selected drive is a saveable setting. For information on Saving Settings, go to the subsection entitled Settings Menu in this guide.

12.9. Online Menu.

Press Alt+N, then one of the following mnemonics. Once Kurzweil 1000 returns results, select the file or files you want to download. All of the features on the Online menu require Internet connection.

S. for Search for Books. Opens a dialog. Alt+S to specify what to search by: Title or Author. Alt+C to type in contents to search for. Alt+T to select and deselect Web sites to search.

L. for Look through the Bookshelves. Go to the description for Search for Books.

M. Search for Magazines. Opens a dialog. Alt+C to type in contents to search for. Alt+F to select beginning month, then Tab to type in the year. Alt+O to select ending month, then Tab to type in the year. Alt+T to select and deselect Web sites to search.

C. for Search the Classic Literature CD. Go to the description for Search for Books above.

E. for Use an Encyclopedia. Opens a dialog. Type in a keyword or phrase. Press Tab to select an Encyclopedia from the list.
N. for News from KESI. Opens a dialog. Kurzweil 1000 searches for items from Kurzweil Educational System, Inc. Press Tab to go to the Items for Download list and make a selection.

T. for Translation. Opens a dialog. Specify the source language, enter text to be translated, specify the translation language, then press Enter. When translation is completed, Kurzweil 1000 reads the translated text passage. You can also Escape or Tab to the status textbox.

U. for Updates. Go to the description for News from KESI.

12.10. Window menu.

The Window menu is visible only if a file is open.

Press Alt+W, then one of the following mnemonics:
N. for Next Document. The keyboard shortcut is Control+F6.
P. for Previous Document. The keyboard shortcut is Control+Shift+F6.

A list of the open documents follows.

12.11. Help menu.

Press Alt H, then one of the following mnemonics:
G. for Register.
R. for Reading Status.
F. for File Management Status.
S. for Settings Status.
O. for Open the Manual. Use document navigation and reading features.
Q. for Quick Reference. Use document navigation and reading features.

N. for New Features. Use document navigation and reading features.

W. for New User Wizard. In the Wizard topic list, use the Up/Down arrow keys to hear the topics. Stop at the desired topic, press Enter to select it. In the topic window that opens, some document navigation and reading features are available. Press Escape to return to the topic list. If a topic has additional options that you want to explore, press Enter.

A. for About.
Section 13. Kurzweil 1000 Settings Tabs (From the Settings Menu)

There are nine Settings tabs. All of them contain Apply (Alt+A), OK and Cancel buttons. It's possible to use the Enter key for OK and the Escape key for Cancel.

Once you open one tab, you can open any of the other ones by pressing the Alt key and the mnemonic for the desired tab.

Use the Tab key to go forward through the controls. Press Shift+Tab to go backward. Or press the mnemonic for the desired control.

Note: Depending on the type of the current control, you may have to press Alt before using the mnemonic of the control to which you want go.

To hear help for any control, press the F1 key.

13.1. The Voices Settings Tab.

The mnemonic for the Voices Tab is E.

The following controls are in the Voices Tab; associated mnemonic follows the name:

Role, R.
Language, L.
Engine, N.
Voice, V.
Pitch, P.
Speech Speed, S.
Volume, O.
Emphasis Method, M.
Emphasis Pitch, H.
Emphasis Voice, C.
Test, T.

13.2. The Scanning Settings Tab.

The mnemonic for the Scanning Tab is S.
The following controls are in the Scanning Tab; associated mnemonic follows the name:
Mode, M.
Page Orientation, O.
Thresholding, T.
Brightness, B.
Delay Between Scans, A.
Resolution, R.
Scanner Source, S.
Batch Scanning Prefix, P.
Document Feeder, F.
Duplex Scanning, X.
Hold Scanner, H.
Brightness Uses Threshold, U.
13.3. The Recognition Settings Tab.

The mnemonic for the Recognition Tab is C.

It contains the following controls; associated mnemonic follows the name:
Identify Columns, C.
Two Pages, T.
Speckle Removal, K.
Text Quality, Q.
Illegible Character, I.
Partial Columns, P.
Suspicious Regions, S.
Blank Pages, B.
Engine, N.
Language, L.
Table Recognition, R. Enabled by default for table recognition.

13.4. The Reading Settings Tab.

The mnemonic for this tab is R.

The following controls are in the Reading Tab; associated mnemonic follows the name:
Reading Unit, U.
Echo, E.
Header Avoidance, A.
Punctuation Level, P.
Numbers, N.
Language Identification, L.
Duration, D.
Table Reading, T. Enable if you want to read a table in a file.
Line Endings, I.
Emphasized Text, M.
Browse Method, B.
Pause for Paragraphs, S.

13.5. The General Settings Tab.

The mnemonic for the General Tab is G.
The following controls are in this Tab; associated mnemonic follows the name:
Page Numbers, B.
Automatic Corrections, C.
Fix Hyphens, Y.
Keep Images, I.
Keep Layout Information, O.
Confidence Threshold, T.
Read Newly Recognized Pages, R.
13.6. The Display Settings Tab.

The mnemonic for this tab is D.

It includes the following controls; associated mnemonic follows the name:

- Tracking, T.
- Color. (Text, mnemonic X. Highlight, H. Background, B. Block Highlight, K).
- Single Font, S.
- Font. (Name, mnemonic N. Size, Z. Bold, L., Italic, I).
- Magnification, M.
- Word Spacing, W.

13.7. The Scanner Margins Settings Tab.

The mnemonic for the Margins Tab is M.

The following controls are in this Tab; associated mnemonic follow the name:

- State, S.
- Back margin, mnemonic B. Front, F. Left, L. Right, R.
13.8. The Configuration Settings Tab.

The mnemonic for the Configuration Tab is F.

It contains the following controls; associated mnemonic follows the name:

File Dialog, F.
Online Cache, C.
Units, U.
Shortcuts, S.
Keypad Commands, K.
Numeric Keypad Layout, N.
Hot Key for Scanning, H.
AutoLoad, L.
Active Speech, A.
Hot Key to Start K1000, Y.
Start K1000 Automatically, T.
Link Documents and Settings, I.
Grayscale Images, G.
13.9. The Verbosity Settings Tab.

The mnemonic for the Verbosity Tab is Y.

In this tab, you'll find the following controls and their associated mnemonics:

Event, E.

Signal, G.

Message, M. (If Signal is Message, this box contains message text and the Restore Default option, mnemonic R.)

Sound, S. (If Signal is Chime, this box contains path and file name of the current sound file, as well as the Browse and Test options, mnemonics B and T, respectively.)

13.10. The Conversion Settings.

To open the Conversion Settings, press Alt+T, then N.

This dialog contains settings for how you want files in particular formats to open and/or to be saved. There are two main controls: Action, mnemonic A and Format, mnemonic F. In the Action list, select Opening Documents or Saving Documents. In the Format list, the selections for Opening Documents are Text, Braille, RTF, PDF, Other, and for Saving Documents, the list consists of Text, Braille and Other.

Subsequent controls depend on the selections you make for the Action and Format.
Section 14. The Kurzweil 1000 Keypad Layers.

There are three main keypad layers in Kurzweil 1000: Reading Keypad (which you can set for Kurzweil 1000 or Screen Reader in the Keypad Commands list in the Configuration Settings tab pane). File Management Keypad and Settings Keypad.

Additional functions for each main layer are available when you hold down the Shift key and press another keypad key. The Shift key is the key in the lower-left corner of the keypad.

14.1. Reading (Kurzweil 1000) Keypad.

The keys for the Reading (Kurzweil 1000) Keypad are as follows, from left to right key, and top to bottom row:


14.2. Reading (Kurzweil 1000) Keypad Shifted.

The keys for the Reading (Kurzweil 1000) Keypad when used with the Shift key are as follows:

Row two. Recognize Currency. No Function. Accuracy or Speed of Recognition Engine. Rescan or Insert Scan.
Row three. No Function. Create Bookmark. Two Pages. Rescan or Insert Scan.
Row four. Rewind by Unit. Forward by Unit. Go To Bookmark. Help and Status.

14.3. Reading (Screen Reader) Keypad.

To use the Screen Reader keypad, select the ScreenReader option for Keypad Commands in the Configuration Settings. The keys for this Keypad are as follows:

14.4. **Reading (Screen Reader) Keypad Shifted.**

To use the Screen Reader keypad, select the ScreenReader option for Keypad Commands in the Configuration Settings. The keys for this Keypad when used with the Shift key are as follows:


Bottom Row. (Shift key). Delete. Help and Status.

14.5. **File Management Keypad.**

Row one, from left to right. Cancel. Favorite Folders. Favorite Files. Accept.


Row two. Folder under Current. The next two keys have no functions. Rescan or Insert Scan.

Row three. First three keys have no functions. The last key is Rescan or Insert Scan.


Last row. (Shift key). No Function. Help and Status.

14.7. Settings Keypad.


14.8. **Settings Keypad Shifted.**

Row one. The first three keys have no functions. The last key is Changes Keypads.

The first three keys in the second row have no functions. The Rescan or Insert Scan is the last key in this row.

Row three keys are Brightness followed by two with no functions, then the Rescan or Insert Scan.

Row four has the Number Pronunciation key followed by two with no functions; then Help and Status.

Bottom row keys are: (Shift key). No Function. Help and Status.
Section 15. Keypad Maps

This section provides "maps" of the keys and their functions for the Kurzweil 1000 keypad layers and Shifted layers.

To switch between layers, hold down the **Shift** key and tap the **Accept** key until you hear the name of the layer you want.

To access a Shifted keypad layer, hold down the **Shift** key and a key on the keypad. For instance, after you press the Shift Accept combination to get to the File Management main keypad press the Shift and number 2 keys to get to its sublayer; this key combination saves your file in export format.

**Reading Keypad**

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Erase Text</th>
<th>Dictionary</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Up</td>
<td>Speed Up</td>
<td>Reading Mode</td>
<td>Start and Stop Scanning</td>
</tr>
<tr>
<td>Volume Down</td>
<td>Speed Down</td>
<td>Multiple Column</td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td>Fast Forward</td>
<td>Go To Page</td>
<td>Help and Status</td>
</tr>
<tr>
<td>Start and Stop Reading</td>
<td></td>
<td>Spell</td>
<td></td>
</tr>
</tbody>
</table>
**Keypad Maps continued: Reading Keypad, Shifted**

The Shift key is the key in the lower left corner of the keypad, or the Control key on the keyboard.

<table>
<thead>
<tr>
<th>No Function</th>
<th>Paste Page</th>
<th>Thesaurus</th>
<th>Change Keypads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recognize Currency</td>
<td>No Function</td>
<td>Accuracy or Speed of Recognition Engine</td>
<td>Rescan or Insert Scan</td>
</tr>
<tr>
<td>No Function</td>
<td>Create Bookmark</td>
<td>Two Pages</td>
<td></td>
</tr>
<tr>
<td>Rewind by Unit</td>
<td>Forward by Unit</td>
<td>Go To Bookmark</td>
<td>Help and Status</td>
</tr>
<tr>
<td>(Shift key)</td>
<td>Spell with Alpha</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Keypad Maps continued: Screen Reader Keypad**

To use this keypad, select the ScreenReader option for Keypad Commands in the Configuration Settings.

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Erase Text</th>
<th>Dictionary</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Up Key</td>
<td>Page Up</td>
<td>Start and Stop Scanning</td>
</tr>
<tr>
<td>Previous Character</td>
<td>Current Character</td>
<td>Next Character</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>Down Key</td>
<td>Page Down</td>
<td>Help and Status</td>
</tr>
<tr>
<td>Start and Stop Reading</td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Keypad Maps continued: Screen Reader Keypad, Shifted

<table>
<thead>
<tr>
<th>No Function</th>
<th>Paste Page</th>
<th>Thesaurus</th>
<th>Change Keypads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speak from Start of Line</td>
<td>Speak Line</td>
<td>Speak End of Line</td>
<td>Rescan or Insert Scan</td>
</tr>
<tr>
<td>Previous Word</td>
<td>Current Word</td>
<td>Next Word</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>Down Key</td>
<td>Page Down</td>
<td>Help and Status</td>
</tr>
<tr>
<td>(Shift key)</td>
<td></td>
<td>Delete</td>
<td></td>
</tr>
</tbody>
</table>
Keypad Maps continued: File Management Keypad

<table>
<thead>
<tr>
<th></th>
<th>Favorite Folders</th>
<th>Favorite Files</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Folder</td>
<td>Make New Folder</td>
<td>Delete Folder</td>
<td>Start and Stop Scanning</td>
</tr>
<tr>
<td>Open File</td>
<td>Close File</td>
<td>Delete File</td>
<td></td>
</tr>
<tr>
<td>Save File</td>
<td>Save As</td>
<td>Export File Format</td>
<td>Help and Status</td>
</tr>
<tr>
<td>Start and Stop Reading</td>
<td>No Function</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Keypad Maps continued: File Management Keypad, Shifted

<table>
<thead>
<tr>
<th></th>
<th>Delete Favorite Folder</th>
<th>Delete Favorite File</th>
<th>Change Keypads</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>Folder under Current</td>
<td>No Function</td>
<td>No Function</td>
<td>Rescan or Insert Scan</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>No Function</td>
<td>Save in Export Format</td>
<td>No Function</td>
<td>Help and Status</td>
</tr>
<tr>
<td>(Shift key)</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
</tbody>
</table>
### Keypad Maps continued: Settings Keypad

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Page Orientation</th>
<th>Number Layout</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reading Voice</strong></td>
<td>System Voice</td>
<td>Scan/Recog. Progress</td>
<td><strong>Start and Stop Scanning</strong></td>
</tr>
<tr>
<td>Dynamic Thresholding</td>
<td>Scanning Mode</td>
<td>Partial Columns</td>
<td><strong>Help and Status</strong></td>
</tr>
<tr>
<td>Punct. Level</td>
<td>Language</td>
<td>AutoLoad</td>
<td></td>
</tr>
<tr>
<td>Start and Stop Reading</td>
<td>Save/ Restore Settings</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Keypad Maps continued: Settings Keypad, Shifted

<table>
<thead>
<tr>
<th>Function</th>
<th>Keypad 1</th>
<th>Keypad 2</th>
<th>Keypad 3</th>
<th>Keypad 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Change Keypads</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Rescan or Insert Scan</td>
</tr>
<tr>
<td>Brightness</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Help and Status</td>
</tr>
<tr>
<td>Number Pronun.</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td></td>
</tr>
<tr>
<td>(Shift key)</td>
<td>No Function</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Section 16. Contacting Kurzweil 1000.

Kurzweil 1000 Support: Toll-free (888) 995-9905 or (800) 894-5374.
Fax: (781) 276-0650
International: (781) 276-0600.
Email: info@kurzweiledu.com
World Wide Web: www.kurzweiledu.com

To subscribe to the Kurzweil 1000 listserv, send an e-mail message to imailsrv@kurzweiledu.com.

The body of the message should contain one line. If you are sending the message from the e-mail account that you wish to use for the list, the message should simply read as follows: subscribe K1000.

If you intend to use a different e-mail address for the list, then the message should read as follows: subscribe K1000 followed by the e-mail address.